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Introduction

NEW FEATURES, FIXES AND CHANGES COMPARED TO TEKLA STRUXML EXPORT 1.1.007

ADDED:

1. Compatibility with Tekla Structures 2018.

NEW FEATURES, FIXES AND CHANGES COMPARED TO TEKLA STRUXML EXPORT 1.1.006

ADDED:

2. Compatibility with Tekla Structures 2017i.

FIXED:

3. Sections rotation was not exported correctly at some cases.

NEW FEATURES, FIXES AND CHANGES COMPARED TO TEKLA STRUXML EXPORT 1.1.005

ADDED:

1. Compatibility with Tekla Structures 2017.
FEM-Design accuracy is used to check the quality of the analysis parts exported from Tekla.

Now also walls are checked against FEM-Design accuracy requirements. If a surface object does
not meet FEM-Design geometry requirements, it will be stopped at the export process. More
about bad geometry errors can be found in Chapter 3.5.4.

3. Possibility to copy object's GUID by right clicking on processed object.

It is now possible to right click on the log line with processed object and copy its GUID that can
be used in order to search for this object in Tekla, struxml file, or in FEM-Design. More can be
found in Chapters 3.5.5 and 3.5.6.

CHANGED:
4. Guid is used as identification parameter, instead of Tekla ID.

Tekla 2017 no longer supports object ID (it still exists in Tekla, but is not a constant value for a
given object anymore, and cannot be used in Selection Filter). Therefore, we introduced
following changes:

- objects are no longer exported with Tekla ID as Name (FEM-Design default names are used
instead, e.g. C, B, P, W),

- in the log area, a GUID of processed element’s parent object (physical object) is listed,
instead of Tekla ID,

- Tekla GUID is now exported to struxml along with an element, instead of random GUID.

FIXED:

5. More clear error message in case a section cannot be found at the export.
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Introduction

1. Introduction

1.1. Manual scope

This document describes the concept behind the link between Tekla Structures and FEM-Design, and
explains how to exchange data between those two programs using the Tekla StruXML Export tool.

1.2. Installation

Download the latest version of Tekla StruXML Export from StruSoft Installer or from FEM-Design
Download Center and run the installation file.

When the installation process is completed, Tekla StruXML Export tool will appear under StruSoft
folder in the Start menu, as shown in Figure 1-1.

. StruSoft
@ Strusoft Installer
. License System
. Revit Add-In
J StruSoft
. Tekla StruxML
55 Tekla StruXML Export =

m

. WIN-5tatik 6.4
. Tekla EIMsight
) Tekla Structures 19.0 -
1 Back
Search programs and files o |
SR
Figure 1-1

1.3. Concept

Tekla StruXML Tool enables direct communication between FEM-Design and Tekla Structures.

The direct data transfer is solely based on Tekla Analysis Model export. The exact geometry of
selected analysis model can be exported to an external file in xml format (struxml), which can be
opened in FEM-Design.

www.strusoft.com Page 7
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Introduction

1.4. Workflow

The workflow to export a Tekla Structures model to StruSoft FEM-Design is shown in the Figure 1-2:

£ Tekla StruXML Export [=l[=][=]
Export e [ Secions | Cade .

File name |C:\Users\lwona\Desklop\Mode\1.slruxm\ |[ P ]

Model 1 Save grids

Processing grid plane (Id: 49365)
Processing grid plane (Id: 49379)

@ Processing objects is finished without problems. Number of succedded / processed objects: 43 / 39
Saving StruXML file CAUsers\lwonah\Desktop\Model Lstruxml

=
@ StruXML export is completed -

About Cancel Close

Figure 1-2

1.5. Transferred data

Open a Tekla Structures model:

- Create Tekla Analysis Model.
- Check and if necessary, adjust the
Tekla Analysis model.

Start the Tekla StruXml Export tool:

- Select the analysis model to export.
- Map the materials and sections.
- Export the model to a struxml file.

Open FEM-Design 3D Structure:

- Open the struxml file in FEM-Design.

- Add loads and supports.

- Modify members end conditions, if
necessary.

- Start analysis and design.

The Tekla StruXml Export tool transfers the geometry of analysis model together with some
fundamental parameters. The list of transferred data is as follows:

geometry of analytical model,

mapped cross-section of linear member (cross-section in start node),

mapped material,

releases of linear members (semi rigid releases are exported as fixed),

rigid links (exported as fictitious bar)
grids system.

www.strusoft.com
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Tekla Analysis Model

2. Tekla Analysis Model

Tekla Analysis model is a structural representation of a Tekla physical model. Analysis model is used
for structural analysis and design, and can be exported into number of FEM-programs, including
StruSoft FEM-Design.

Tekla analysis model is generated automatically based on existing physical model geometry and
according to some predefined settings. In many cases the analysis model however, requires some
adjustments before it can be successfully exported to a FEM-program. Since the exact geometry of
analysis model is exported, it is extremely important to make sure that all analysis parts are
connected with each other and that the model is consistent.

Therefore, in this chapter some basic information regarding Tekla Analysis Model is gathered. Areas
such creating analysis model, model display options, model connectivity check, and model
adjustments are covered.

Please note, that to get the best overview of Tekla analysis model, it is highly advised to get familiar
with the official Tekla Analysis Guide.

2.1. Creating analysis model

More information:

U What is Tekla analysis model?
Creating Analysis model
Analysis model properties

To create an analytical model of an existing Tekla physical model, one shall go to Analysis tab and
start Analysis and Design Models... A new dialog will pop out (Figure 2-1), where one can create and
modify analysis models.

[67 Tekia Structures 164 - S\DevelopmentTekia Link\Tutoriah T itorial model - View1 -3

& File Edit View Modeling [[SIEH] Detailing Drawings & Reports Tools Window Help

DE|<goRE ok 'ESH | FRPRT| [ SF NTECX A BB SH» @
awy 0] 0% o I

#

%
L)

Analysis Part Properties

2 Anslysis & Design Models ===

P rties
ropertie Create

opd | Analysis model name Creation method  Results Partcount Load count Warning coul|

ZGc|uy Vl=RE

Add selected objects| [Remove

Load combinations... |

Refresh | Rebuild |

[V] Automatic refresh

=§AeNYVI=

< i »

Analysis application interface

Export Open application| | Close application

Getresults | [Get results for selected

|

Figure 2-1
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Tekla Analysis Model

Press New to create an analysis model. An Analysis Model Properties dialog will pop out (Figure 2-2).

Here you can:

- give an unique name to the analysis model,

- decide about the model creation method (full model, or selected parts),
- define which objects should be included in the analysis model, based on one of the selection

filters,

- define secondary members,
- choose an analysis application - note that Tekla StruXML Export tool is not listed here so this
parameter is not relevant.

& Analysis & Design Models

Analysis medel name

Creation method Results

Create

Part count Load count  Warning coul

[=le=]

Properties..

Select objects

Delete

Display warnings

&5 Analysis Model Properties

- (sl

Analysis model | Analysis | Job | Output | Seismic | Seismic masses | Modal analysis | Design - Steel | Design - Concrete | Design - Timber

Add selected objects | | Remove selected objects

Load combinations...

Refresh Rebuild

Autematic refresh

Analysis medel name:

Creation method:

Filter

Secondary member filter

Model 1
Full model
MNone

Auto-detect secondary members

Browse for export folder

Analysis application

More settings..

v []Set as the default

Figure 2-2

Press More settings... to see the other available settings (Figure 2-3).

Close

Analysis application

Less settings

v []Set as the default

Use rigid links Disabled, with keep axis: Default -
Default keep axis for secondary members Mo M
Analysis model rules Analysis model rules...

Curved beams Split into straight segments -
Consider twin profiles Disabled -
Member axis location Model default -
Member end release method by connection: Ne M
Autematic update Yes - Physical model changes are considered =
Maodel merging with analysis application Disabled -

4
Figure 2-3
www.strusoft.com Page 10
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Tekla Analysis Model

Here, among other things, you can decide:

- if to include rigid links in the analysis model,
- location of the member analysis axis (neutral axis, reference axis, model default).

Note that ‘Automatic update’ and ‘Model merging with analysis application’ parameters are not
relevant in case of integration with FEM-Design.

Press OK. Analysis model will be constructed and listed in the Analysis & Design Models dialog as
shown in Figure 2-4.

q %lysisansign Mode V [E=%(ECR (=) |

Create

Analysis model name Creation method  Results Part count  Load count  Warning c

£ Coj
iModel1 Full model 72 0 6

[ Properties... ] [ Delete ]

[ selectobjects | A\ [ Display warmings |

[Add selected objects| | Remove selected objects|

[ Load combinations... ]

[ Refresh Il Rebuild ]

Automatic refresh

< m

Analysis application interface

[ Export | [Open application| [ Close application |

[ Get results ] [Ge'( results for selected]

Figure 2-4

In Tekla it is possible to create many analysis models independently. Each of the analysis models
can be built upon different settings, or can include different parts of the model.

&2 Analysis & Design Models =0 E=R F=5)
Analysis model Creation method A I PO v—
nalysis model name reation metho esults art coun oad coun arning ¢

[ coms ]

Model 1 Full model 72 0 6 —

Model 2 - Top floor By selected parts and loads 20 0 12 -

Model 3 - Ground floor By selected parts and loads 18 0 8 | i | | Bekis |
| Select objects | | Display warnings |
|;1\dd selected 0bject5| |Remo\.fe selected 0bject5|

| Load combinations... |

| Refresh || Rebuild |

Automatic refresh

< 1 B

Analysis application interface

| Export | |Open application” Close application |

| Get results | |Get results for 5&Iected|

Figure 2-5
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Tekla Analysis Model

2.2. Model display options

2.2.1. Node and bar numbers visibility

If you do not wish to see an analysis bar, member, or node number in analysis model view, go to
Tools -> Options -> Advanced Options and set the following parameters to FALSE:

- XS_AD_MEMBER_NUMBER_VISUALIZATION
- XS_AD_NODE_NUMBER_VISUALIZATION
- XS_AD_NODE_NUMBER_BY_Z

Close and reopen an analysis model in order to apply the changes.

Figure 2-6

> More information:
a Showing analysis bar, member, and node numbers

2.2.2. Physical objects visibility

If you wish to hide a physical model and display only analysis parts, double click on the screen to
start the View Properties. Go to Display and uncheck the visibility of ‘Parts’ in model (Figure 2-7).

v T »
&3 View Properties I &5 Displa
— Settings | Advanced
standard -
ander tondard i
A Visibility Representation
View I In model 1 s
@ Name: e m n model In compenent
[7] Angle: (30 + [IRotationaround Z: ~ -33.50 LI | Al
N :
— =
Projection: () Orthogonal + [FRotationaround : 3175 W[ poires
Representation Parts Exact -
Color and transparency in all views: standard v |Representation...| | Wireframe v
Visibility In components: Shaded wire frame  ~
View depth: [7] Up: 25000.00 I
[¥1Down: 200000 Bolts Fast -
Visibility of object types: | Display...
e ity of object typ | Display.. | P Exact -
[¥] Visible object group: standard | Fre—
{4 | Welds Fast -
oK Apply Modify Get F/TC Cancel :
[ I ] I [i7iu] | | P—— .
. " —
Figure 2-7
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2.3.  Analysis model check

2.3.1. Analysis nodes colors

In Tekla, each analysis part has node at its end or corner. These analysis nodes can have one of two
colors: magenta or green, depending on its connectivity status (Figure 2-8 (source)). Magenta color
means that a node is disconnected, and the green color means that a node is connected. Checking
nodes colors is therefore, a good way to visually verify the model connectivity.

Note that not all disconnected nodes are bad. Some of the nodes e.g. at the corner of unsupported
slab or at the corners of openings will always be marked as disconnected.

More information:

U Analysis nodes colors

Node color Connectivity status Selection Example

Magenta Disconnected Selected

Magenta Disconnected Not selected
Green Connected Selected
Green Connected Not selected

Figure 2-8 (source)

2.3.2. Checking warnings

Tekla can check an analysis model against some criteria. If there are some recognized problems with
the analytical model, one shall go to Display Warnings in Analysis & Design Models dialog and press
Details to see a full list of warnings / errors (Figure 2-9).

\ More information:

%) Checking warnings about analysis model

www.strusoft.com Page 13
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Tekla Analysis Model

E Analysis 8 Design Models

Analysis model name Creation methed Results Part count Lead count  Warning o

Model 1 Full model 72 0 6

E Tekla Structures @

.--r : There were warnings/errors in the model creation:

Properties...

Select obje

- Analysis element warning(s)

WABNING: Bar 53 is not fully connected or supported, part Id: 15810
WARNING: Bar 52 is not fully connected or supported, part Id: 15825
‘- WARNING: Bar 50 is not fully connected or supported, part Id: 15302
WABNING: Bar 5% is not fully connected or supported, part Id: 26431
WABNING: Bar 56 is not fully connected or supported, part Id: 26358

WABRNING: 55 i: fully connected

<

Analysis application interface

’ Export ][Dpenapplica

Get result]

Figure 2-9

Press CTRL+5 (shortcut to show only selected objects) and select one of the warnings. The
corresponding element will be highlighted in the model.

(=1=r=]

Create

Analysis model name Creation method Results Part count Load count Warning cq
:

Full model

s Tekla Structures @ [ Riopeilicss ] [ Belels ]

i‘: There were warnings/errdys in the medel creation: [ Select objects ] A I Display warnings I

- Analysis element warning ‘Add selected object5| | Remove selected objects‘

connected supported, part
connected supported, part

connected supported, part H
connected supported, part Id: 26358
connected supported, part Id: 26400

o

Analysis application interface

Open applicq
Get result]

Figure 2-10
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Tekla Analysis Model

2.4. Analysis model adjustment

In many cases an automatically generated analysis model requires some smaller or bigger
adjustments, in order to create the most accurate structural representation of a Tekla model.

Tekla Structures offers a few different possibilities on how to modify and adjust position of analysis
members. Most of the adjustments possibilities are found in an individual analysis part properties
dialog (Chapter 2.4.1) but some manual modifications are also possible (Chapter 2.4.2). Examples of
both can be found in the following paragraphs.

2.4.1. Analysis part properties

More information:

U Analysis part properties
Modifying the properties of an analysis part

Double click on any analysis part to access its analysis properties (Figure 2-11). The settings
available in the Analysis Properties dialog vary depending on the object type and its class.

E Concrete Slab Analysis Properties - Model 1 @
Save | |Load| standard ~ |Saveas| standard
Analysis - - - Spanning | Loading | Design | Position = Area attributes

Analysis member properties

V| Class Slab - Shell -

V] Built-up section mode Mot part of built-up section -

| Design group

V| Automatic update Yes - Physical model changes are considered ~

oK | Apply || Modify || Get || Vi | Cancel

Figure 2-11

Note that properties found in other tabs than ‘Analysis’, ‘Start / End releases’ and ‘Position’ are not
relevant in case of exporting the Tekla analysis model to FEM-Design.
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Tekla Analysis Model

24.1.1. Analysis member class
Analysis properties dialog -> ‘Analysis’ tab -> ‘Class’

Here one can change a class of an analysis member. A ‘Class’ parameter defines how Tekla
considers a certain analysis member in analysis.

&2 Concrete Beam Analysis Properties - Model 1 ===
Load| standard * |Saveas| standard
Analysis I Start releases | End releases | Composite | = | Loading | Design | Position | Bar attributes | = |
Analysis member properties
Class  — Beam E
[¥] Built-up section mode  Beam -

i Bearn - Truss —
Design group Beam - Truss-Compression only
Beam - Truss-Tension only
Beam - Ignore
Secondary
Secondary - Truss
Secondary - Truss-Compression only
Secondary - Truss-Tension only
Secondary - Ignore
Slab - Shell
Slab - Plate
Slab - Shell
Slab - Plate
Slab - Membrane
Slab - Mat foundation

oK I A Slab - Rigid diaphragm Get /T

Slab - Ignore

Automatic update red -

Figure 2-12

One can for instance:

- Ignore a certain analysis member in analysis model (set it to ‘Ignore’),

- Change an analysis member class to another one, e.g. change a hollow core member class from
‘Beam’ to ‘Slab’. This way Tekla Structures will handle the hollow core as a slab member (Figure
2-13), and it will be exported as a plate object to a FEM-Design.

Class: Beam Class: Slab

Figure 2-13

) More information:

E. Analysis class options
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Tekla Analysis Model

2.4.1.2. Analysis member axis position
Analysis properties dialog -> ‘Position tab -> ‘Axis

Here is where one can decide upon position of an analysis part in relation to the physical object.

&5 Concrete Slab Analysis Properties - Model 1

standard - standard

‘Anal.ysxsl - | - | - | nmnglLoadmngaigr' Poswhonl - IAlea

[ Axis ———  Middleplane [z
Neutral axis
Keep ais position Reference axis (eccentricity by neutral axis)

Reference axis
Connectivity Top left -
Top center
Top right
Middle left
Middle center
Middle right
Bottom left
Offset Bottom center
Bottom right
Longitudinal offset mode  Top plane
Middle plane
Bottom plane
Left plane
Right plane

Middle plane (of left/right]
OK Apply—pn(—mu%n;—n—u!

[¥] Axis modifier X
[¥] Axis modifier ¥

[¥] Axis modifier Z

Figure 2-14

The drop-down list contains all available options however, some of them are used only for beam
objects, or some of them only for plate objects.

Nota that Tekla Structures uses this position when constructing analysis mode if a ‘Model default’ is
chosen from the ‘Member axis location’ list in the Analysis Model Properties dialog (Figure 2-3).

) More information:

g Analysis axis options

Example:

The analysis model of the structure visible in Figure 2-15 (concrete floor placed on the top of a
beam) is not constructed well. Both the individual objects have their analysis part placed in the
neutral axis (default ‘Axis’ location for those objects was set to ‘Neutral Axis’), so there is no
connection between the two members.

Figure 2-15
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Tekla Analysis Model

To adjust the model:

- Double click on the analysis slab to activate the Concrete Slab Analysis Properties and set the
‘Axis’ position to ‘Bottom Plane’,

- Double click on the analysis beam to activate the Beam Analysis Properties and set the ‘Axis’
position to ‘Top center’.

& Concrete Slab Analysis Properties - Model 1
standard * [saveas) stoncerd |
|Analysis| - | - | - |spanning | Loading | Design| Posiion | - | Ares
[7] Avis [Bottom plane -|
Keep axis position No -
&2 Beam Analysis Properties - Model 1 (=l
stendard - [savess] standard
| Analysis | Start releases | End releases | Composite | - [ Loading | Design | Pesition | Bar attributes | - |
Pois | Top center -]
Keep axis position No -
Connectivity Automnatic -
Figure 2-16

2.4.1.3. Analysis members connectivity
Analysis properties dialog -> ‘Position tab -> ‘Connectivity’

Here is where one can decide if an analysis part is allowed to snap, or connect with rigid links to
other parts.

&= Concrete Slab Analysis Properties - Model 1 (23]
Load| standard ¥ |Saveas| standard
| Analysis | - | - | - | Spanning | Loading | Design |IP05iti0ﬂ I - | Area attributes
(V] Axis Middle plane -
Keep axis position Yes - Keep end positions also -
Connectivity == Automatic E
Automatic
[¥] Axis modifier X Manual |
(] Axis modifier ¥ MNone T ¥ 0.0
Figure 2-17

The available options are:

- ‘Automatic”: The analysis member snaps or connects with rigid links to other members.

- ‘Manual”: The analysis member does not snap or connect with rigid links to other members.
Automatic connectivity to other members is created only if the member position matches the
other member exactly.
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Example:

a. The ‘Connectivity’ parameter for all the walls visible in the plan view in Figure 2-18 is set to
‘Automatic’ therefore, the objects are allowed to snap to each other to create a consistent
analysis model.

Figure 2-18

b. The ‘Connectivity’ parameter for all the walls visible in the plan view in Figure 2-19 is set to
‘Manual’ therefore, the objects are not allowed to snap to each other. The analysis model is not
accurate.

Figure 2-19

The ‘Manual’ connectivity can be used in order to prevent an object from automatic snapping to an
object that it should not be connected with.

2.4.1.4. Keep member axis position
Analysis properties dialog -> ‘Position tab -> ‘Keep axis position’

Here, one can decide whether the axis position of a part is kept or adjusted to the position of
adjacent objects. There are five options:

- 'No": the axis is free to move when snapping end positions to nearby objects. Use this option for
secondary members.

- ‘Partial — keep in major direction’: the axis is free to move partially, but the member is not
moved in the major (stronger) direction of the part profile.

- ‘Partial — keep in minor direction”: the axis is free to move partially, but the member is not
moved in the minor (weaker) direction of the part profile.
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‘Yes': the axis is not moved, but the end positions can move along the axis (thus extending or
shortening the member).

- ‘Yes — keep end position also”: The axis and the end positions of the member are not changed.

E Concrete Slab Analysis Properties - Model 1 E

[ﬂ] standard

~ |Saveas| standard

\Analysis | - | - | | Spanning | Loading | Design | Position | | Area attributes
[¥] Axis Middle plane -

Keep axis position = Yes - Keep end positions also

-]

Mo

Connectivity Partial - Keep in major direction
Partial - Keep in minor direction
[V] Axis modifier X Yes
Yes - Keep end positions also
[¥] Axis modifier ¥ Rl L
Figure 2-20
Example 1:

A concrete slab is placed on the top of concrete beam. The edge of the slab is aligned with the
beam side as shown in Figure 2-20.

V

Figure 2-21

Here is how the analysis model of the example structure looks like, depending on the ‘Keep axis
position’ settings applied to the slab:

a. ‘Keep axis position”: ‘Yes — keep end position also’

Since the axis and the end position are restricted from changes, the analysis slab is aligned with the
edges of physical slab and therefore, is not aligned with the analysis beam.

& Concrete Slab Analysis Properties - Model 1

standard

Analysis| - | - | - | Spanning | Loading | Design| Position | -

Botton plane. -

| Yes - Keep end positions akso

Automatic
9] Axis modifier X None v x
(] Asis modifier Y None - oo
9] Axis modifier Z None v z

(7] Offset X 000 V. 000

Longitudinal offset mode  Offsets are not considered

Figure 2-22
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b. ‘Keep axis position”: ‘Yes’

The slab axis is restricted from changes, but its ends are free to move. Therefore, Tekla Structure
can adjust one of the slab edges to connect with the beam axis position.

& Concrete Slab Analysis Properties - Model 1

standard - standard

D R
A== [~ [Spaning Londi e Poven | = Ao

7] s

Keep ayis position

Connectivity
s modifier X
Ais modifier V
s modifier Z
Offset

Figure 2-23

Example 2:

Two beams are connected with each other as show in the figure below. Here is how the analysis
model looks like, depending on the ‘Keep axis position’ settings applied to both the beams.

a. ‘Keep axis position”: ‘Yes — keep end position also’

Since the axis and the end position are restricted from changes, the analysis beams are extended to
the edges of physical beams and therefore, do not snap to each other.

Figure 2-24
b. ‘Keep axis position”: ‘Yes’

Beams axes are restricted from changes, but their ends are free to move. Therefore, Tekla Structure
can adjust both the beams ends, so they can snap to each other.

standard - standard

Analysis | Start releases | End releases | Composite | - | Loading | Design| Position | Bar attributes | -

(] Avis

Keep axis position
Connectivity

[¥] Axis modifier X
[¥] Axis modifier ¥
[¥] Axis modifier Z
Offset

Longitudinal offset mode

Reference axis

[res

Automatic
None - %

Neme v v

None v

x 000 ¥: 000

Offsets are not considered

Figure 2-25
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2.4.2. Manual adjustment
2.4.2.1. Move special

Analysis nodes and analysis parts can be moved, just as other Tekla objects. A particularly useful
command to do so is ‘Move Special’ -> ‘Linear’.

Note that any change applied to the analysis part does not influence the physical object.

' More information:
\‘_
Moving an object linearly to a new position

Example 1: Moving an analysis part

A concrete slab is placed on the top of concrete beam. The analysis slab and analysis beam are not
placed in the same plane.

Figure 2-26

To adjust the model:

- Right click on the analysis slab, go to ‘Move Special’ -> ‘Linear’

Interrupt

Properties...

Inquire

Copy

Copy Special

Move
Move Special
Delete

Hide

Zoom
Update Window
Next Window

Figure 2-27

- If you know the distance between the elements, type it in the ‘dZ' box (to move an element
downwards, type the number with *-' ). Otherwise, pick two nodes from the model to indicate
the movement direction and calculate the distance, as shown in Figure 2-28.
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s Move - Linear

dX 000
dy 000
dZ  -100.00

Figure 2-28

- Press Move. The analysis slab will be moved 100 mm in the Z-direction.

Figure 2-29

Example 2: Moving an analysis node

Two analysis beams shown in Figure 2-30 are not connected with each other.

Ll

Figure 2-30
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To adjust the model:

- Right click on the node that you wish to move, go to ‘Move Special’ -> ‘Linear’

Interrupt

Properties...

Inquire

Move

Move Special Linear...

Delete Rotate...

Mirror...

To Another Plane
To Another Object

Merge Selected Nodes
Hide

Zoom
Update Window
Next Window

Figure 2-31

- Chose Pick, and select the two nodes to indicate the movement direction, and press Move.

s Move - Linear

[Z]dX 5000

dy  -200.00
dZ 000

(o] [Meve | [ cleer | (/T [ conce |

Figure 2-32

2.4.2.2. Merging analysis nodes

It is possible to merge two analytical nodes into one single node.

More information:

Merging analysis nodes

Example:

- Select the two columns ends.
- Go to Analysis -> Merge Selected Nodes.
- Select the target node in the upper column.
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Figure 2-33

www.strusoft.com Page 25



Exporting Tekla Structures model to FEM-Design

3. Exporting Tekla model to FEM-Design

This chapter contains a step by step guide on how to export a Tekla Structures model to StruSoft
FEM-Design. A sample model is used to demonstrate the process.

3.1. Create an analysis model

a. Open a Tekla Structures model. The example model is a concrete structure composed of panels,
slabs, beams and columns.

Figure 3-1

b. Go to Analysis -> Analysis and Design Models...
¢. In Analysis & Design Models dialog press New to create an analysis model.

£7 Tekla Structures x64 - S:\Development\Tekla Link\TutoriaNTutorial model - View1 - 3d
& File Edit View Modeling [SINEH| Detailing Drawings & Reports Tools Window Help

0P H|<GERE ‘o 'ES O ERPBE| % SR N TELCL OB SRSk »AE
TXTEIRRNE - oo |
&2 1#: Create Node
a By
] & M
= 7
= Lo}
= Analysis Part Properties =
= & Analysis & Design Models ===
Properties ’ it

@ T _rd | Analysis model name Creation method ~ Results  Part count  Load count  Warning coul
L ¢
el [ propetties.. | Delete ]
i [ selectobjects | [ Displaywarnings |
1| [Add selected objects| [Remove selected objects|
= |
=| [ Load combinations.. ]
4 [ refesh | Rebuild ]
= I Automatic refresh
@l -

e

Figure 3-2
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d. Define analysis model properties.

In this example, a full analysis model is defined with no rigid links allowed, and the axis location is
set to model default, as shown in Figure 3-3.

e.

&5 Analysis Model Properties

¥ |Saveas

Analysis model | Analysis | Job | Output I Seismic | Seismic masses | Meodal analysis | Design - Steel | Design - Concrete | Design - Timber
Analysis model name: Model 1]
Creation method: e Fulll model R
Filter MNone A
Secondary member filter Auto-detect secondary members -
Analysis application ™[] Set as the default

Less settings
Use rigid links i Dlisabled, with keep axis: Default -
Default keep axis for secondary members Ne A
Analysis model rules Analysis model rules...
Curved beams Split into straight segments -
Consider twin profiles Disabled -
Member axis location e Model default -
Member end release method by connection: Ne M
Automatic update Yes - Physical model changes are considered =
Model merging with analysis application Disabled -

Figure 3-3

Press OK. An analysis model will be constructed and listed in the Analysis & Design Models

dialog as shown in Figure 3-4.

&2 Analysis & Design Models

Analysis model name
Model 1

Creation method Results Part count Load count Warning c(

Full model 72 0 6

<

Analysis application interface

[ Eport | [Gpen application| [ Close application |

[ Getresutts | [Get results for selected|

Figure 3-4

Create

:

[ properimn | |

Delete ]

[ seiectobiects | A [ Display warnings |

| Add selected objects| | Remove selected objects|

[ Load combinations... ]

[ Refresh Il Rebuild ]

[¥] Automatic refresh

www.strusoft.com

Page 27



Exporting Tekla Structures model to FEM-Design

3.2. Check and adjust an analysis model.

a. In the first (optional) step turn off the visibility of members and nodes numbers.
Go to 7ools -> Options -> Advanced Options, and set the following parameters to FALSE:
- XS_AD_MEMBER_NUMBER_VISUALIZATION
- XS_AD_NODE_NUMBER_VISUALIZATION
- XS_AD_NODE_NUMBER_BY_Z
b. In Analysis and Design Models dialog press Display warnings and Details, to see the list of
warnings.
The report says that there are several bar members in the example Tekla model that are not
fully supported.
E Analysis & Design Models EI@
Create
Analysis model name Creation method Results Part count  Load count Warning ce
E Tekla Structures @ ’ Riopeifiess ] ’ Belete ]
ij There were warnings/errors in the model creation: ’ Select obieg A_ﬂ—-l Disel.axwaminf I
- Analysis element warning(s) Add selected objects | | Remove selected objects
[ ok || petails.. | [ : ]
N\ St (= Hol ==
Report
WABNING: Bar 53 is not fully connected or supported, part Id: 15810
WAENING: Bar 52 is not fully connected or supported, part Id: 15825
‘ WARNING: Bar 50 is not fully connected or supported, part Id: 15302
WABNING: Bar 59 is not fully connected or supported, part Id: 26431
WAENING: Bar 56 is not fully connected or supported, part Id: 26358
i connected or supported, :
Figure 3-5
C. Localize the members listed in the warnings list.

Press CTRL+5 (shortcut to show only selected objects) and select one (or all) of the warnings.

The corresponding element(s) will be highlighted in the model.

o & Analysis & Design Models

==

Analysis model name Creation method Results

Model1 Full model 72

& Tekla Structures

[==]

2 There were warnings/errors in the model creation:

Part count

Create
oad count ammgk

I

[ selectobjects | A [ Display waming

[ properties.. Delete

Add selected objects| | Remove selected obje

- Analysis element
List |
o e |
G: Bar 55 is not fully comnected or supported, part Id: (

G: Bar 59 is not fully cor or supported, part Id:

G: Bar 56 is not fully cor or supported, part Id:

G: Bar 50 is not fully cor or supported, part Id:

G: Bar 52 is not fully cor or supported, part Id:

G: Bar 53 is not fully comnnected or supported, part Id:

Figure 3-6
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d. Zoom into each of the members to check the exact problem.

In this example the problem is that analysis axis of each of the listed beams do not connect with
the adjacent objects (walls, columns), as shown in Figure 3-7.

: Bar 55 is not fully connected or supported, part Id: 26400

: Bar 59 is not fully connected or supported, part Id: 26431
: Bar 56 is not fully connected or supported, part Id: 26358
: Bar 50 is not fully connected or supported, part Id: 15902

Figure 3-7

e. Check the analysis properties of the listed members.

f.

To do so, double click on one of the analysis beams in the model, or right click on the warning
message and choose Analysis Properties.

| Analysis Properties

Set as New Main Part of Assembly
Inquire Center of Gravity {
Show with Exact Lines

Hide

Show Only Selected =

Show Assembly
Fit Workarea to Selected Parts

O\

Create View

Task

Zoom

Figure 3-8

Change ‘Keep Axis position” parameter from ‘Yes — Keep end position also’ to ‘Yes'. Press Modify.

ctandard . ctanind

| Analysis | Start releases | End releases | Composite | - [ Loading | Design | Position | Barattributes | - |
Asis Top center -
Keep axis position Ves - Keep end positions also [z
No
Connectivity Partial - Keep in major direction

Partial - Keep in minor direction
s moditerx.  —o [

Ves - Keep end positions also
Axis modifier ¥ rone YUY

[V Asis modifier Z None -z o

[¥] Offset X 000 Y. 000 Z 000

Longitudinal offset mode  Offsets are not considered -

Figure 3-9
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g. Select next unsupported element (in the model or in the warning list) and press Modify to apply
the new settings. Apply the properties to all listed beams.

h. There are no more unsupported elements in the model, but not all the model inconsistencies are
listed in the Warnings list. Therefore, check the model visually and verify the nodes connectivity.

Visual checking the example model shows that there are some disconnected nodes (in magenta
color) on the top two floors. The nodes are located along the floor perimeter as shown in Figure
3-10.

Figure 3-10

i. Zoom into the disconnected nodes area. It looks like the analysis slabs are not connected with
beams underneath, and that they are not well connected to the walls, as shown in Figure 3-11.

IA*_-_-_-_-_-__Q v —

Figure 3-11
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j.  Double click on one of the analysis slabs to open the analysis properties dialog.
Figure 3-12 shows how the default properties for this slab look like:

- ‘Axis’ is set to ‘Middle Plane’. That is why the analysis slab is not aligned with the analysis beam
underneath.

- ‘Keep axis position’ is set to ‘Yes — Keep End position also’. That is why the slab edge is not
aligned with the wall in the horizontal direction.

O O
O -
e standard - [E] standard

‘ Analys%\ I o | - I Spanning I Loading I Dsign| Position ‘ . I Area

[¥] Asis \:Middleplane 1 -

Keep axis position 'Yes - Keep end positions also I -

Connectivity Automatic -

[¥] Axis modifier X MNone v X 000

] Axis modifier ¥ Mone * v 000

[¥] Axis modifier Z MNone -~ 7 000

Figure 3-12

k. Change the slab properties to the following, and press Modify.

- ‘Axis’ -> ‘Bottom Plane’

The analysis slab position is now moved to the bottom of the physical slab and therefore, is
aligned with the analysis beam.

- 'Keep axis position’ -> ‘Yes’

The edges of the slab are now adjusted to the position of the walls, and the wall height is
adjusted to the new (vertical) position of the slab.

w-~ Concrete Slab Anal

ete Slab A sis Properties - Model
standard - standard

[Anaysis| - [ - - | spanning [ Loading [ Design | Position | - | Area atwii

V] Auis Bottom plane -

Keep axis position Yes

Figure 3-13

I.  Select the other analysis slab and click Modify, to apply the same properties to it. The model is
now fully connected.
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3.3. Tekla StruXML Export

Keep your Tekla model open. Go to Start Manu, then to StruSoft Folder. Find Tekla StruXML folder
and run Tekla StruXML Export.

a. In the first step, select the design code so the correct libraries can be loaded in the mapping
dialogs.

5 Tekla StruXML Export o ||[= | =]

1 ; Euroccode -
Export | Materials | Sectim— Cada [ ! l
9 Select code =

File name - H Browse l
Code independent
Model 1

Euroccode (MA: British)
Eurccode (MA: Danish)
Euroccode (MA: Finnish)
Eurccode (MA: German)
Eurccode (MA: Hungarian)
Eurccode (NA: Morwegian)
Eurccode (MA: Swedish)
Eurccode (MA: Polish)

Connected to Tekla 5

Figure 3-14

b. The left upper window shows all analysis models that are created in the current Tekla Structures
model. Select the model you wish to export. Now the program will collect information about all
the materials and sections used in that model.

5 Tekla StruXML Export =N R

Export | Materials | Sections | Code ... Eurocode v]

File name |S:\Develc:-pmenfﬂekla Link\TuteriahTutorial model-23-0?-2n15mnalysisw|[ Browse ]

Model 1 Save grids

Connected to Tekla Structures 21
Maodel 1: Collecting current materials and sections..
@ Model 1: Materials and sections collected

Figure 3-15

c. Decide whether to export grid system or not. Check / uncheck the Save grids box in the upper
right window, as shown in Figure 3-15.

www.strusoft.com Page 32



Exporting Tekla Structures model to FEM-Design

d. Go to Materials tab. Here one shall map all the materials used in the Tekla Structures model to
corresponding materials from FEM-Design library.

Note that if you have a custom material library in FEM-Design, you shall update the material
library in the Tekla StruXML Export tool to the current FEM-Design material library before you
start the mapping process.

To do so go to FEM-Design, start Beam/Column command -> Default Settings ->Materials tab, ->
Export and save the library as a .struxml file type, as shown in Figure 3-16. Use the Load
material library to import the new library into Tekla StruXML Export tool.

Stucture  loads  Finteelements  Analysis  Foundation design  RCdesign  Steeldesign  Timberdesign  Ferfomman

e 0 @ean ST AL AAATEIEEIZ] 000

Datum Foundation Bar Plate Wall Support Modeling tool

|e3@AREn= gL+t ANBDLIBAE] - OO0 A #]
LEA+Ea0aFIEE+T 98 &6l &lE |
7

[Eurocode

Beam =

|12 10MTH L] /@00

SR

Bearn/Column =]
cenrs | T seeer | [] mml il Matena\l
Library a jon da | |
- Concrete M
1oy Ultin] [ Save As =
cis/20 Bl | ammaciis [19 @\J" 18 » Twona » Downloads - [ #3|[ search Downloads 2|
c20/25
|| | Gammas.. MR =
cas/30 Organize = New folder - ®
-~ C30/37 Gamma & o -
€35/45 ) R
..Ca0/50 Alpha cc... A Favorites H No items match your search.
asfss Apha Ct oo & Downloads =
C50/60
\ o e, 15,05 [ 09 %] Recent Places
B Deskiop
5238 Shrinkage [%e] ........... —
5275 @ Autodesk 360
<358 Reduction for dynamic anal ®) iCloud Photos
5420 | | Reduction for stabilty anal E Google Drev
aam
new... |[ modfy || Delete | [mport. ||Expert. ' 5
\ File name: New material library -
Save as type: [fstruSoft XML ("struxmi) | =
—
Figure 3-16

e. Map the materials

There are two concrete materials used in the example model and both have to be mapped (as
they are marked in red), as shown in Figure 3-17.

5 Tekla StruXML Export = Ech <=

Materials | Sections Code ... | Eurocode Vl
| Show current materials || Apply | | Load material library |[ Reset |
C25/30 : =]
C30/37 : Steel

Timber

General

Connected to Tekla Structures 21

Figure 3-17
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Select a material in the left dialog, then select a corresponding material in the right dialog (FEM-
Design library) and press the < button. Mapped material will turn black. Press Apply.

%) Tekla StruXML Export =N =R
Materials | Sections Code ... |EBurocode vl
[Shc:rw current materials = H Apply ] [ Load material library H Reset ]
C25/30 : C25/30 4 Concrete |
C30437 : C30/37 C12/15
C16/20
C20/25 =
€25/30
C35/45
C40/50
C45/55
CEN RSN N
‘ Connected to Tekla Structures 21 |
Figure 3-18

f. Go to Sections tab and map all the sections used in the model to corresponding sections from
FEM-Design library.

Note that if you have a custom sections library in FEM-Design, you shall update the sections
library in the Tekla StruXML Export tool to the current FEM-Design sections library before you
start the mapping process.

g. Map the sections.

This time not all the sections have to be mapped. One of the concrete sections (500x300, as
shown in Figure 3-19) has been already mapped before in another project and the program
remembers the mapping choice.

59 Tekla StruXML Export o] 2| [wE3)
| Export | Materials | Sections | Code ... |EBurocode vl
[Shc:rw current sections = ” Apply | [ Load section library H Reset l
3007300 - Concrete sections
5007300 : Rectangle300x500 Steel sections

Timber sections
Hollow Core

Connected to Tekda Structures 21

Figure 3-19
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Map the remaining section. The procedure is the same as in case of materials mapping. Press
Apply when you are done.

I

5 Tekla StruXML Export =N =R
| Export | Materials | Sections | Code ... Eurocode vl
[Shc:rw current sections = H Apply ] [ Load section library H Reset ]
300%300 : Square300 4 Concrete sections -
5007300 : Rectangle300x500 Rectangle |
4 Sguare 3
150
200
250
300
350
400
ACN -
Connected to Tekla Structures 21

Figure 3-20

h. Go back to Export tab.
Press Browse to find a new name and location for the export file (if necessary) and press Export.
i. Check the export status and if there were any problems with exporting the model.

Exporting the example model was successful. The report says that 114 out of 114 objects in the
analysis model (including grids system) have been exported to the struxml file.

£ Tekla StruXML Export =] =[]
Export | Materials | Sections | Code ... Eurocode vl
Filz name |C:\Users\lwona\Deslep\TekIa Export TutorialhMedel 1.struxml H Browse l
Model 1 Save grids
(1
Processing grid plane (Id: 135) -
Processing grid plane (Id: 121)

Processing grid plane (Id: 1

Processing grid plane (Id: 79)

Processing gnid plane (Id

Processing grid plane (Id: 52)

@ Processing objects is finished without problems. Number of succedded / processed objects: 114 / 114 i
Saving StruXML file CA\Users\lwonah\Desktoph\Tekla Export TutoriahModel 1.struxml

@ StruxmL export is completed -

About Cancel l [ Close l

Figure 3-21
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3.4. Open struxml file in FEM-Design.

a. Start FEM-Design 3D Structure.
b. Go to File > Open and browse for the struxml file type, as shown in Figure 3-22.

File Edit Draw Medify Teools Settings View Window Help - O
Structure | Loads  Finite elements  Analysis  Foundation design  RC design  Steel design  Timber design  Feformance bazed desian

Recent Places

Desktop

Libraries

Computer

@
< MNetwork | m 3
A, File name: -

Files of type [StruSokt common structure XML file {strol) _+]
FEM-Design. 3D Structure (" str} L

FEM-Design, Plate (" pla)
FEM-Design, Wall (*wal)
FEM-Design, 3D Frame {*frm})

%a@ﬁ@%%gf%Xf%%%%ﬂﬁikiﬁi

Datum Foundation Bar Plate WWall Support Docu...
|‘@’@>r—|nnnl : — L Lew o Lo o P — LA #
BT e = AH
ISR
. . 1 i
Erorode Look in . Tekla Export Tutorial - 9 ¥
T= MName = Date modifii
el 7 Model 1 24-07-20151

|FC files (" ifc)
AutoCAD drawing (".dwa)
StruSoft comman structure XML file * struxml) i
ol ArchiCAD exchange format (* fdx)
Figure 3-22

The exported Tekla analysis model is now imported to FEM-Design.

0

File Edit Draw Modify Tools Settings View Window Help -

Structure | Loads  Finite elements  Analysis  Foundstion design  RC design  Steel design ~ Timberdesign ~ Ferfom

L ¢|¢BOMAABA=Lalt=~+-080LIBRIN) - vOcoDa| A #]

Eurocode
Filter [=]

e v

AN
17

o

i
[
/73
oy

£
By

e @e AND A0 N S i b § &1

Datum Foundation Bar Plate Wal Support Docu...

Qonaas | L P

8 | & & | [ >

Figure 3-23
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3.5. Errors at exporting an analysis model.

There are a few possible situations when the export of a Tekla Structures analysis model may not be
successful. All the recognized issues are described in the following paragraphs.
3.5.1. Lack of material definition

For the successful export it is required that each of the analysis part has a valid material assigned to
its physical representation. It is because it is not possible to have an element in FEM-Design that
does not have a structural material.

Figure 3-24 shows an example, where a concrete column in Tekla model does not have any material
assigned to it. Such element will not be exported and following error message will be sent:

“Cannot find matching material defined, the object will not be saved”

2
Fel e e 52 £ Tekla StruXML Export =1 EEH =)
Eurocode -
Export | Materials | Sect Code ... I
ctandard - stondard po laterials | Sections
File name | CATeklaStructuresModels\New model 44%AnalysistColumn - No mater\al\Co\“ Browse l
Adttribute Positi Cast unit | Def -
ributes | Position | Cast uni orming <] | [[cotmn o matera T Save grids
Name COLUMN A
Profile 4007400 -
7] Material el
Finish
Class 1 T _
User-defined attributes...
[ ok |[ apply |[ Modiy |[ et |[F /][ cancel "

Figure 3-24

The same error message will be shown if the material assigned to the element in not present in the
Tekla material catalog.

3.5.2. Lack of material / section mapping

If one forgets to perform material or section mapping, following error messages will be thrown and
the objects that were not mapped will not be exported.

“Cannot find matching material (section) defined, the object will not be saved”

5 Tekla StruXML Export — O *
Export | Materials | Sections Code ... | Eurocode :
Show current materials = Apply | | Load material library | | Reset
C25/30 : f— - I Concrete
S2350R @ 5235 > : i:f:féer

I General

Frocessing analys

object GUID: 7

@ ca d ﬂ'a-'.:ﬂ'ng m

ng analysis bar (P

Figure 3-25
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3.5.3. Invalid mapping

If one accidentally maps a material to a wrong type of section, or the opposite, a following error
messages will be thrown:

“Invalid mapped material and section combination. The bar will not be saved ()"

Export | Materials | Sections Code ... | Eurocode -
Show current sections - Apply | ‘ Load section library || Reset
4007400 : Sgquare400 p Concrete sections
8007400 : HE-A100 " m’ :

Timber sections
HEA300 : HE-A300 Hollow Core
HEA400 @ HE-A400

Processing ana object GUID

Processing analy object GUID

Processing analysis bar (P object GUID

a Invalid mapped material and section combination! The bar will not be saved! ('C25/30'

Figure 3-26

3.5.4. Bad surface geometry

In FEM-Design it is required that surface elements (plates and walls) are defined in one plane only,
with a certain accuracy. In Tekla Structure however, it is possible that an analysis slab or analysis
wall has nodes that are out of plane. In this case, one of the following error messages will be thrown
and such element will not be exported:

- "The analysis area has out of plane point(s)! The analysis area will not be saved!”

- "The wall vertically does not meet FEM-Design requirements! The analysis area will not be
saved!”

- “Improper region! The analysis area will not be saved!”

In each case, one can search for the bad object using the method given in Chapter 3.5.5, and try to
fix the analysis part of the object (using methods given in Chapter 2.4.
3.5.5. How to find a certain element in Tekla?

When exporting a model to struxml, Tekla StruXML Export shows a GUID of a parent object
(physical member) for each processed object. The message in the log dialog looks like this:

Maodel 1 Save grids

Connected to Tekla Structures 2017
Maodel 1: Collecting current materials and sections..
@ Model 1: Materials and sections collected
Model 1: StruXML export is started
I Processing analysis bar (Physical object GUID 1F8-05AEB ES:GCCL'}I
object GUIL T A-BAALOETTLET)
object GUID FD3 H00-945045C4AF04)
object GUID: 2725D586-8280-4890-B264A-A208D44D87 D)
Figure 3-27
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This is the same GUID that one can see in Tekla, when using Inquire objects:

& |nquire Object — a =
GUID: |ID49BEDAAT-BEET-474C-B1F8-05AEBEBDSCC]| Type: [2 Assembly phase: Part phase:
e —— ;
Hame Profile Material Grids Bart Aggembly
pogsition pogition
COLUMN HER400 5235JR Z2/B c/0(2) Cro02)

Part GUID: ID4SBEDAAT-BEEV-474C-Bl1FE-0SRAEBEBOSCCE

Global coordinates:

Start point = H= «000.0 mm ¥= c000.0 mm Z= 0.0 mm

End point = H= «000.0 mm ¥= a000.0 mm Z= TZ00.0 mm

Center of grawvity : H= 2000.0 mm ¥= ©000.0 mm Z= 3c00_.0 mm

Top level : +7.Z00

Bottom level :  +0.000

Local coordinates, TCS:

Start point : H= «000.0 mm ¥= e000.0 mm Z= 0.0 mm

End point = H= «000.0 mm ¥= c000.0 mm Z= T200.0 mm
Figure 3-28

If there is a problem with a certain object, an error message will be thrown just under the processed
object log (as shown in figures in previous paragraphs).

In order to find and correct the object (or group of objects) that failed the export, one can use the
Selection Filter in Tekla Structures.

Example:

There are a few objects that have not been exported due to lack of valid material definition. One can
see the error messages (always displayed under the processed object) in Figure 3-29.

5 Tekla StruXML Export — O s

Export | Materials | Sections Code ..., [ Burocode -

File name |C:\TeklaStructuresModels\New model 23VAnalysis\Model 1\Medel 1.struxml H B |
Processing analysis bar (Physical object GUID: SEF5CE4A-90F2-447E-B128-248307098C54) —|
Processing analysis bar (Physical object GUID: TODB166C-8224-42D4-993F-B120A21FARAR)

Cannot find matching material defined, the object will not be saved (Tekla m| Copy Guid for FEM-Design
Processing analysis bar (Physical object GUID: 50A2F971-E359-4919-8DCA-§ Copy Guid for Tekla

Cannot find matching material defined, the object will not be saved (Tekla marerar—c=
Processing analysis bar (Physical object GUID: 952BAD47-ABC4-4471-87D2-6DD5E4839
Cannot find matching material defined, the object will not be saved (Tekla matenal: 'C25/ 3"”

r

Processing analysis area (Physical object GUID: 8DFAAT3E-4084-4727-A581-2846435455C5)
Cannct find matching material defined, the object will not be saved (Tekla material: "C25/30°)
Processing analysis area (Physical object GUID: OEGOABFE-BRAS-4D8A-BEGE-86259E142982)

Cannot find matching material defined, the object will not be saved (Tekla matenal: 'C25/30°)

Processing grid plane (1d: 4861)

Processing grid plane (Id: 4838)

About  Manual Cancel | ‘ Close

Figure 3-29
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To find a specific object in Tekla model:

a. In Tekla StruXML Tool right click on the log entry that refers to the object you want to search for
- here, it is always displayed above the error message, and press Copy GUID for Tekla.

b. In Tekla Structures start the Selection Filter (Ctrl+G).

c. Create filter definition according to the following rule (shown in Figure 3-30):
- Category: Object

- Property: GUID

- Condition: Equals

- Value: here paste the copied GUID (e.g. use Ctrl+C)

d. You can add several rows into the filter, by repeating steps a-c.

e. Save the filter and click Apply and OK.

As you can see in Figure 3-30, when choosing Copy Guid for Tekia, the GUID is copied with the
ID prefix (thus the division; FEM-Design requires GUID without the prefix).

& Object Group - Selection Filter *
Save/Load
~ | | Save standard Save as EES
Objects with matching properties can be selected
-0 Category Property  Condition  Value ) Andy... Add row
- Object Guid Equals ID70DB166C-8224-42D4-993F-B189A31F4BAR - Or ey .
- Object Guid Equals ID30AZFI71-E359-4919-8D CA-66A486012843 - Or
- Object Guid Equals ID952BAD4T-ABCA-4471-8702-6DD5E4839CE8 - Or
- Object Guid Equals IDEDFAATIE-4084-4727-A581-2846435435C5 - Or Move up
- Object Guid Equals IDOEGSABFE-BFAS-4DEA-BEGE-36259B142582 - Or = I
Move down
Mew filter
K Apply Cancel
Figure 3-30

f. Use CTRL+5 and select the whole model. Only the elements of the given GUIDS will be selected.
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Figure 3-31

Also, the Tekla GUID is now assigned to the exported object in struxml file (in previous version of
the Export Tool, the struxml GUID was assigned randomly and was not compatible with Tekla).

If you want to search for a specific object in the struxml file, I recommend using the Copy Guid for
FEM-Design option (it copies the GUID without the ID prefix).

ij XML Motepad - ChTeklaStructuresModels\Mew model 23\Analysis\Model 1\Model 1.struxml — a x

File  Edit View Inset Window Help

A [3 H & E3 ﬂ ){\ H O = = CATeklaStructuresModels\New model 23Wnalysis\Model 1\Mode ~
Tree View XSL Qutput
o xml version="1.0" encoding="utf-g8" ~
[ 9 database
oo il EMInE:xad http://www.w3.0rg/2001/¥MLSchema
& zmlns:xsi http://www.w3.0rg/2001/¥MLSchema-instance
[ struxml wversion 01.00.000
[ source_software Tekla Structures Z017
p— start_time 2017-05-09T10:14:54.45340612
- end_time 2017-05-09T10:14:54.4534061Z
& guid 50dcebc5-f121-4e38-B3a5-58f50%c5adad
- i ZM1NE urn:strusoft
[ E} entities
EIE} bar
™ last_change 2017-05-09T10:09:31.60309692
& action added
& type column
EJ bar part
8 end
+--I2) bar
+--I2) bar
+--IJ) bar
-2 par
-2 par
- advanced-fem
F--IJ) storeys
[]E:l axes
- sECtions
il materials
- end v

Figure 3-32
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3.5.6. How to find a certain element in FEM-Design?

To find a specific object in FEM-Design model that was created from a struxml file exported from
Tekla:

g.

In Tekla StruXML Tool right click on the log entry that refers to the object you want to search

for, and press Copy GUID for FEM-Design (Figure 3-29).

In FEM-Design, start Find tool (Tools -- > Find).

In Find tool:

select Guid,

paste the copied GUID,

press Enter.

The object will be selected in red, as shown in Figure 3-33.
Find B
AL w[0]

D | 49BEDAAT-BEE7-474C-B1F3-05AEBEBDSCCE |

I;Pa Press Enter to find object.

Figure 3-33
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